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UKLADY KOMBINACYJNE

Wprowadzenie. Zadanie przyktadowe |. Metoda Karnaugha. Schemat sprzetowy. Program
w C. Program w ST. Program w LD. Program ST w $rodowisku TwinCAT PLC Control.
Program LD — PLC Control. Niepoprawne pomiary. Zadanie przyktadowe II.

WPROWADZENIE

1. Uklady przelaczajace

e Podziat
Uktady kombinacyjne (bez pamigci)
Uktady przetaczajace —
Uktady sekwencyjne (z pamigcia)
e Realizacje sprzetowe
Uklady kombinacyjne — bramki bez sprzezen zwrotnych
Uktady sekwencyjne  — przerzutniki, bramki ze sprz¢zeniami zwrotnymi

e Opis matematyczny

:> Uklad :>
X przeltaczajacy

t Yt

Uktady kombinacyjne — Y, = A(X,)— aktualny stan wyj$¢ zalezy wytacznie od
aktualnego stanu wejsc.

Q1 =0(Q. X))

Y, = ,U(Qt, Xt)

Stan wyjs¢ zalezy od wejs¢ i stanu wewnetrznego (zaleznego od poprzednich
wejs¢ — pamieC: Yi = u(0(0r1, Xt-1), X))

Uktady sekwencyjne — { — Qt stan wewnetrzny

2. Metodologia projektowania ukladéw kombinacyjnych

Sformulowanie tablicy wejs¢/wyjsé
Utworzenie funkcji przetaczajacej metodg Karnaugha
Realizacja sprzetowa — bramki
Realizacja programowa (jezyki C, ST, ew. inne)
— funkcja przetaczajaca  — wzor (podstawowa realizacja)
— schemat bramkowy — funkcje AND, OR, NOT
— tablica wejs¢/wyjsé — indeksem do tablicy jest kombinacja we/wy
— zestaw instrukcji if ... then ... else odpowiadajacy tablicy we/wy
¢ Niepoprawne pomiary



3. Struktura programu w prostym sterowniku

Inicjalizacja

Odczyt wejsé¢

!

Obliczenia

'

Ustawienie wyj$¢

Wizualizacja (ew.)

'

Oczekiwanie

Cykl wykonywania programu — np. 10 ms, 0.1 s lub ponowne rozpoczgcie zaraz po
poprzednim wykonaniu.
Wizualizacja — LEDy, bargrafy, wyswietlacz LCD.

. Sterowanie nagrzewaniem

c

ZADANIE PRZYKLADOWE |

Jummp IS

a

Zadanie:

as
b<
c<

a, b, c: 00— temperatura ponizej poziomu

—»G1 1 — temperatura powyzej poziomu
lub mu réwna
— G2
G1, G2 — grzejniki
t<a Gl G2 - obydwa grzejniki wlaczone
t<b

t<c
t

. Tablica wejs¢/wyjs¢

c b a|Gl G2
0001 1
00 1|1 O
0110 1
1110 0

Gl -
> . &

Inaczej — tablica zero—jedynkowa, tablica prawdy

Uwaga. Stany nie ujete w tablicy reprezentuja awarie
czujnikoéw pomiarowych (typowa reakcja na uszkodzenie
— wylaczy¢ zasilanie).



METODA KARNAUGHA

1. Reguly tworzenia tablic Karnaugha

Chodzi o sformutowanie mozliwie prostego wzoru, aby utatwic¢ realizacj¢ sprzetowg (w
realizacji programowej znaczenie minimalizacji jest mniejsze).

e Wyjscia rozpatruje si¢ oddzielnie.
o Wspotrzedne pol elementarnych opisane sg refleksyjnym kodem Graya.
e Puste pola uzupetia si¢ znakami nieokreslonosci (-).

2. Tablice zadania

G1 G2

3. Reguly upraszczania — laczenie pol elementarnych

e Wszystkie pola ,,1” muszg by¢ objete
e Liczba pol taczonych ze sobg musi by¢ potega 2 (1, 2,4, 8, ...).
e Polaczone pola musza tworzy¢ prostokat lub kwadrat, im wigkszy tym lepie;j.
e Pola,,-” dotgcza si¢ do pol ,,1”.
e Pola moga zachodzi¢ na siebie.
e Gorny i dolny wiersz uwaza si¢ za sasiednie, jak rOwniez lewa i prawag kolumne (ze
wzgledu na kod Graya).
Gl G2
\ ba \ ba
c \_00 01 11 10 ¢ \_00 01 11 10
01 1y 0 -
1 - -/ 0 -

4. Tworzenie wynikowych wzoréw — kolumny

o Wypisa¢ kolumny wejs¢ odpowiadajace zakreslonym obszarom.
e Utworzy¢ iloczyn z tych wej$¢, ktére w wypisanych kolumnach majg niezmienione

wartosci (stale 0 lub 1), przy czym 1 odpowiada sygnatowi prostemu, a 0 —
Zanegowanemu.

e Wynikowy wzor jest sumg wzordw powstalych z zaznaczonych obszarow.



2.
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c b a c b a c b a

0 0O 0 0 O 0 1 1

0 0 1 1 0 O 0 1 O

100 01 0 [

1 01 1 1 0 ce*b — iloczyn
! I
b a

Gl=b G2=a+bhc — suma

Uwagi. Zaznaczenie zbyt malych obszaréw w tablicy Karnaugha nie jest btgdem, ale
wynikowy wzor si¢ rozrasta (nie jest minimalny), bo iloczynéw w koncowej sumie
przybywa. Zjawisko hazardu obecne w realizacjach sprz¢towych nie wystepuje w
realizacjach programowych, poniewaz obliczenia s3 wykonywane w tym samym cyklu
(nie ma roéznicy czasOw propagacji bramek).

SCHEMAT SPRZETOWY

o}
=]
Q|

o |

bc D: a Gl

Ty )
¢° [ be

c

Programowym odpowiednikiem schematdéw sprzetowych jest graficzny jezyk FBD.

PROGRAM W C
Operatory logiczne

char — typ zmiennych logicznych
I negacja, && iloczyn logiczny, || suma logiczna

char a,b,c,1,G2;

Gl='h;
Gz=la| |b&&'c;

if ... else — tablica wejs¢/wyjs¢



if('ces'bee'la) {G1l=1; G=2=1:}

else
if('ces'beea) {G1l=1; G=2=0:}
el=e
if('eeebhiga) {G1l=0; G2=1:}
elze

1G1=0; G2=0:}

Wersja powyzsza ujmuje takze przypadek z niepoprawnymi pomiarami (G1=0, G2=0 —
zob. dalej).

PROGRAM W ST

Norma PN-EN 61131-3: 2004(4). Sterowniki programowalne. Czegs¢ 3: Jezyki
programowania definiuje pi¢¢ jezykow:

ST - tekst strukturalny (Structured Text)

IL - lista rozkazoéw (Instruction List)

LD - schemat drabinkowy (Ladder Diagram)

FBD — funkcjonalny schemat blokowy (Function Block Diagram)

SFC - sekwencyjny schemat funkcjonalny (Sequential Function Chart)

Bedziemy stosowac pakiet TWinCAT sterownikéw PLC/PAC firmy Beckhoff.

1. Operatory logiczne 2. IF...THEN...ELSE
~2 MAIN (PRG-ST) ] /> MAIN_IF (PRG-ST) (=13
D001[PROGRANM MAIN_OPERATORY ~ DO0E[vAR ~
oo, 0003 &, b, c G1.GZ:BOOL
D003 AR, D004END_ AR =
0004 & b.c GI. G2 BOOL < >
D005 EMD_AR - DOOA[IF (NOT & AND NOT b AND NOT &) THEN ~
f0ne 3 5 0002|  G1=TRUE GZ=TRUE
—— nnoFELSE
DO0H]G1 = NOT b; 0004 IF(NOT ¢ AND NOT b AND &) THEN
D002|G2 == NOT & OR b &4ND NOT ¢ i G1:=TRUE; G2:=FALSE:
ITiE 000§ ELSE
onn 0007 IF (NOT ¢ AND b AND &) THEN
< - iTiE G1:=FALSE: G2=TRLUE:
000s ELSE
0010 G1:=FALSE; G2=FALSE
0011 END_IF
oig  EMDF
n0isEND_IF
0nd A bt
4 >
1. Elementy
—| |— zmienna wejsciowa prosta — argument

—| / |— zZmienna zanegowana



—( )— zmienna wyjsciowa — rezultat

I | szczebel — ,,pusty” wzor

2. Operacje logiczne

Suma lloczyn
a C a b C
( 11 (
\ N \
b
c=a+hb c=a-eb

3. Program - zadanie |

= MAIN_LD (PRG-LD)

FROGRAM MAIN_LD
AR
a b.c G, G BOOL:
END_VAR
| nnn=
I 5 | 3
oot
b ey
1/1 ; E ;
............. I/I i H ‘ _
nonz Gl=D
o G2
i/} { o
G2=a+bc
4] =
— 1/
£ | 3

PROGRAM ST W SRODOWISKU TWINCAT PLC CONTROL

1. Uruchomienie systemu

e System > Start — jesli system jest juz uruchomiony, to Start wyszarzone.

T About TwinCAT. ..

=| Log Wiews
- Swskem Manager
BE rLC Contral




Odpowiedz Cancel na pytanie o rejestracje.

e PLC Control

B About TwinCAT...

= Log Yiew
. Syskem Manager

23 PLC Contral

,DE.:' Realtime Settings

Rouker L

Syskbem r

Pojawia si¢ okno TwinCAT PLC Control z ostatnio uruchamianym projektem.

~ & IwinCAT PLC Control - Zbiornik Z1 Z3.pro

File Edit Project Insert Extras  Online  indow Help

el e e A 2 [ Y

~'- MAIN (PRG-ST)

“§[Z] MaIN [PRG) 0001 [PROGRAM bAIN
000ZvAR
K ®1%2 71,23 BOOL: stan: INT:=1;

2. Nowy projekt

e File > New

= IwinCAT PLC Control - Zbiornik 71 Z3.pro

F[EN Edit  Project  Insert Extras Online  Window Help

Mew From template. ..
oper. ..
Close

e Typ systemu docelowego
Symulacja i prace domowe — PC or CX (x86)
Laboratorium — CX(ARM)

!

Choose Target System Type

f+ PC or O [#85) £ CR[ARM)
(" BC wia AMS Cancel

" BC serial
(" BCxx50 or Bl via A5
(" BCxxB0 or B via serial




e Jezyk programowania — ST

New PO 3
Marne of the new POL: [FAAIM]
Type of POL Language of the POU Cancel
* Proagrarn I
™ Function Block LD
" Function " FBD

Return Type: " SFC
= ST
" CFC

Pojawia si¢ puste okno edytora programu z Untitled jako nazwa projektu. Gorna czes$é
jest przeznaczona na deklaracje zmiennych i blokéw funkcjonalnych, a dolna na
wiasciwy kod.

= IwinCAT PLC Control - (Untitled)*

File Edit Project Insert

Extras Online ‘Window Help

el = E R e A e A e =

=

------ MAIN [PRG)

A2 MAIN| (PRG-ST)

FPREOGEAR BAIN
AR
EMND_ AR

3. Kodowanie, kompilacja
e Deklaracje i kod

A= MAIN (PRG-5T)

0001 {FROGRAR b4
000z AR
o003 a.b.c.G1.G2: BOOL;
ooo4EMRD_ AR
= Jfimm] 2
0001f=1 = MNOT b
0002(=2 = MNOT a OR b ANMD MNOT o
o003
aoo-<
A | >

Insert Extras Online ‘Window Help

Euild Ckrl+Fa

Rebuild all
| Clean all

i Load download information. ..



Informacja o wyniku kompilacji w dolnej czgséci okna

Size of used data: 43 of 1048576 bytes (0.0022)
Size of used retain data: 0 of 32768 hytes (0.00%)
0 Errar(s), 1 WWarningis).

4 |

Na warningi nie nalezy zwraca¢ uwagi.

e Zapis pliku
File > Save

A= TwinCAT PLC Contrd
Edit Project Insert
[

Mews From template. ..

Open...
Close

Save as...

Nalezy najpierw utworzy¢ Katalog na pliki projektu (ktorych moze by¢ nawet
kilkanascie), tutaj katalog Sterowanie nagrzewaniem, i w nim zapisa¢ plik z kodem
zrodtowym — tutaj Nagrzewanie.pro (rozszerzenie dodawane automatycznie).

Zapisywanie jako

Zapisz w | £ Sterowanie nagreewaniem = IfF E-
Zapizz jako |TwinC.-'—‘-.T PLC Control Project [*.pra] - Ay
tpp:

4. Symulacja

e Online > Choose Run—Time System...

olyy-M ‘Window  Help

Laogin F11

Choose Run-Time System. ..

Create Bootproject {offline)
Delete Bookproject



e Local > RunTime 1 (Port 801) - lokalny komputer PC

Choose Run-Time System

=-¢ ~Local-- [132.168.255.100.1.1) ok
IEC : \—l

Ll Fun-Time 1 [Port 807)
+- 8 0775 (B7121.2110) Cancel
+ -8 <Defaulty  [255.255.255. 255,255, 255)

e l.adowanie programu
Online > Login

=N Wwindow  Help

| Lagin F11

Odpowiedz Tak na pytanie o zatadowanie programu.
Poczatkowe warto$ci zmiennych.

A p -
£
b
G1 = MNOT b
G2 =MNOT a OR b AND MO
| | 20§10 | >

e Online > Run

(sl =N Window  Help

Logouk F1z
Run FS
Reset

| ¥

oo o
= un

(£

-10 -



5. Zapisywanie nowej wartosSci

e 2kl. zmienna
Pojawia si¢ proponowana nowa wartosc.

nom a= <=TRLE>
nooz b=

|

e Online > Write Values lub Ctrl+F7

Ckrl+F7

6. Zakonczenie

e Online > Logout

m LR IRIN IS LIz

: Logouk

PROGRAM LD - PLC CONTROL

1. Nowy projekt, typ POU, jezyk LD

e File > New
e PC or CX (x86)
e language — LD

M arne of the new POLU: ’m
Type of POL Language of the POU Cancel
= Program L
" Function Block = LD
" Function " FED

Return Type: " SFC

[ [ ST

" CFC

Okno edytora LD — deklaracje w gornej czesci (j.p.)
— dolna czg$¢ przeznaczona na schemat; widoczny jeden szczebel
drabinki.

-11 -



= MAIN (PRG-LD)

oaot
oaoz
0ao3

fatalal]

FPROGRAR MAIN
A
EMND_wAR

2]

&l | |

2. Tworzenie schematu LD

e Wybor miejsca, menu kontekstowe
schematu, np. Contact (negated).

(prawy klawisz myszy) > wybodr elementu

= MAIN (PRG-LD)
0o |PROGRAR kAAIN
a00z|wAaF

ooz

ool

ab.cGl.G2:.B0O0L;

Ehirm s

= [

Cuk Chrl4%
Copty Chrl+C
Paske Chrl+W
Delete Del

Metwork (before)
Mebwark (after)

CerlT

Conkack Chrl4K
- Chrl+a
Chrl+R
Cerl4-O

Parallel Contack
Parallel contact {negated)

Function Block ...
Rising edge detection
Falling edge detection
Timer (TR

Chrl+B

Zoil
'set’ coil
'Reset’ coil

Chrl4L
CErI-T

Pojawia si¢ styk zanegowany, bez nazwy zmiennej — pytajniki ???

e Nazwa zmiennej

Zaznaczy¢ ?7? > przycisk F2 > okno Input assistant > wybor zmiennej, np. b.

= MAIM (PRG-LD)

- MAIM (PRG-LD)

0007| PROGFAM BAIN 0001 PROGRARM hAIN
0002 &R 0002 AR
0oo3 ab.cGl.GZEOOL g003 ab.cGlLGZ:EOOL
OO0 A ChIF WA OO0 A ChIMF WA AT
0| <
0001 aoot
: {23 Local Variables
Global Vfariables ;
F Sypztem Vanables T A BL
|f I b [BOOL]
T c[BOOL)
g G (BOOL)
e g G2 EOOL)

-12 -



e Pelny schemat

A= MAIN| (PRG-LD)

aooz
0003 AR
aoon4 a b.c Gl G2: BOO0L:

QOos EMND_ AR
O00c

D001 PROG Fushd bAAIN -

s

= ]|

|

0o

=

nonz

L.
-

I
0

>

e Kompilacja Project > Build
e Zapis pliku File > Save
Najpierw utworzono katalog Nagrzewanie LD na pliki projektu.

Fapisywanie jako

Zapisz W |L':_} Magrzewanis LD j = 5 ER-

Mazwa pliku: |Nagrzewanie LD
Zapizz jako |TwinD’l\.T PLC Control Project [*.pra) - Ay

tep:

3. Symulacja

e Online > Choose Run—Time System > Local > RunTime 1 (Port 801)
e lLadowanie Online > Login (poczatkowe wartosci zmiennych)
e Uruchomienie Online > Run

aoot
aooz
aoos
aoo4
aoos
aoos
aoo?

| ¥

oo o|m
=0

IR AL

£

-13-



4. Nowa warto$¢ zmiennej

e 2Kl styk, np. a
e Polowa styku zmienia kolor; proponowana nowa warto$¢ widoczna takze w gornej
czesci okna (deklaracje).

ool
ooz
oo 3|
ooo-
[nfufujs
0006

000 TP ES
N

< |

e Cirl + F7 lub Online > Write Values

ool a= -
aooz b= E
non3 o=
ooo4 1
0oas Gz
aoae e

s} G

[ ] |

a G2

b c

NIEPOPRAWNE POMIARY

1. Tablica poprawnosci pomiaréw

P =1 — pomiary poprawne
P =0 — pomiary niepoprawne

P P P PO O O oo
P P OO PFrr L O OoO|T
b Ok O PFrr O PFr Ol
R O OO pFr O F +—|T

-14 -



2. Tablica Karnaugha

ba
c 00 01 11 10 Uwaga. Teraz w tablicy Karnaugha dotyczace;j
’ e poprawnosci pomiaréw nie ma pol ,,-” (nie ma
0 E ! 0 nieokreslonosci).
1(0 01, 0
3. Wzér B
P=cb+ab

4. Wymaganie technologiczne

W przypadku niepoprawnych pomiaréw obydwie grzatki nalezy wytaczyé — G1=G2=0.
5. Programowanie

Cc

char P: A4 poprawnoss pomiaraw

P=assh| | 'bes!c:

if (P)
{Gl=1h: G2Z=la||b&s!lc:?
elze
{1G1=G2=0:1
ST LD
+'Z MAIN (PRG-ST) M =1[E3
0001 FROGRAM bAIN D0 =, b.c. G1, G2 BOOL,
o0onavar 0004 P-BOOL:
0003 = b.c G1,G2 BOOL paad =
004 P BOOL o
OD05EMD_WAR
0005 = b P
fatal ke _| I I I ()_
< > 0002
DO0IP = aAND B ORMOT B AND MOT & & b . .
oonz ) 141 { —
0003|IF P THEN b
D004 Gl :=MOTh: —
D005 G2 =MOTaORbANDMNOT ¢ T
O00BELSE ) . a
D007  G1:=G2=FALSE: | | ;
: /
DODGEMND_IF o i/t = -
ooog] ¥
£ 3 <] [=3 P Ge
— 1 | (]
—
< >
P=a-b
P=P+b-c

-15-



ZADANIE PRZYKLADOWE 11

1. Sterowanie nagrzewaniem

Wilaczanie grzejnikow:
e réwnolegle G1, G2,
tylko G1,
tylko G2,
szeregowo G1, G2,
wytaczone G1, G2,

Potaczenie powyzsze pozwala uzyska¢ cztery stopnie mocy grzejnej

pkK

grzejnikach.

2. Tablica wejsé¢/wyjsé

gdy t<t,
gdy t,<t<ty
gdy tp<t<t;
gdy t.<t<ty
gdy ty<t

d ¢ b a|w w, ws
0 0 0 0|1 1 O
0 0 0 1|1 O

0O 0 1 1|0 1 O
0O 1 1 1|0 1 1
1 1 1 1/]0 0 O

zasilanie

-16 -
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3. Tablice Karnaugha i kolumny

W1 d ¢c b a
"\ ba 0000
dc \_00 01 11 10 0001
0 - 0100
0 - 0101 _
0 - 1100 W7P
- - 1101
1000
1001
b
Wy d c b a d ¢c b a
"\ ba 0000 0011
dc \_00 01 11 10 0010 0010
00| I\ o (1 0110 0111
1| -| - W1 0110 0110 R
1| -| - o |- 1100 g b |Wemahd
100/ - - 1110
1000
1010
a
W3 d ¢c b a
"\ ba 0 100
dc \_00 01 11 10 0 101 =
0o[o o o - 0 111 V87F¢
01(- - 1 -) 0110
1/ - - 0 - d ¢
00- - - -
4. Programowanie — stan normalny
c
char d,wl,wz,w3: — dodatkowe deklaracje

wl='h: w2=la| |b&e!d; wi=ces!d:;

ST

-17 -



+= MAIN (PRG-ST)

0001 FPROGRARM AN ~ O003 o5 oo ve w3 BOSL:
000z AR [IE|
0003 a b.c odwl w2 w3 BOOL ﬁ‘ —
0004 EMD_WAR b
( > b bl
— o N (]
0007wl o= MOT b ~ ooo2
0002pwe = NOT a OR b AND NOT d; a w2
DDDSIW31=|:AND MNOT d; 2 /1 { —
= b d
< X — k444444J
003
=3 = wd
| 171 { —
< >

5. Niepoprawne pomiary

Tablica poprawnosci

\ba

dc \_00 01 11 10

Zmienna P

o | s, "
C) dcb \__) cba ‘dca

P =dch+cba+dca
Programowanie

Cc

char P:

P='d&s'ces'b || cesbasa || 'des!cssa;

if (P

fwl='h; wz='!a||b&e'd; wi=c&&'d:}
else

wl=wZ=w3i=0;

-18-



= MAIN (PRG-ST)

0001|PROGRAR MAIN

EBEX

D00E|aF

0003 a b.codowl, w2 wl BOOL

0004 F:BOOL

DO0G|EMD_WaR

0006
am >

D001P = NOT d AND NOT cAND NOTh OR ~

0002 cANMDhANDa  OR

0003 NOT b AND NOT cAND a; B

0004

DO0E|IF P THEM

0006 wl = NOT b

0007 w2 = NOT a OF b AND NOT d;

0008 w3 = c AND NOT o

D0DSELSE

0010 wl = w2 = w3 = FALSE;

D0NEMD_IF

0012 .
< | >
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